@ Shasta Colle = Worksite Learning Instructor Checklist
— 9

THE INITIAL JOB SETUP MUST BE COMPLETED BY THE STUDENT FIRST, AFTER WHICH YOU WILL RECEIVE AN EMAIL FROM THE
WSL SYSTEM LETTING YOU KNOW THE JOB IS READY FOR REVIEW AND APPROVAL.

Download and review the WSL Instructor Guide — linked here:
https://wsl.shastacollege.edu/Guides/InstructorGuide.pdf

JoB REVIEW, OBJECTIVES & APPROVAL — LOG IN AND PERFORM THE FOLLOWING:

1. JOBS tab:
[J Review the job information posted by the student - see page 5-6, items 2 & 3
2. OBIJECTIVES tab:
[J Review and/or Edit the individual objectives after discussing with student — see page 6,
items4 &5
3. JOBS tab:
[] Click the Instructor Approval checkbox and SAVE — see page 6, item C.1

INSTRUCTOR WORKSITE VISIT — LOG IN AND PERFORM THE FOLLOWING:

4. TIMESHEETS tab:
[J Enter your worksite visit information and comments — see pages 6-7, items 1-3

AT THE END OF THE TERM — LOG IN AND PERFORM THE FOLLOWING:

5. REPORT tab:
[] If you asked students to submit a report, you can view them here — see page 7, items
1&2
6. EVALUATION tab:
[J View the evaluation of the student from the Worksite Supervisor — see page 8, items 1-4
[1 Onthe Comments/Approval subtab, select the Instructor Approval checkbox and SAVE
—see page 8, item 5

TIP: The Instructor guide is designed to give you step by step screen shots and instructions on using the
system. Please reference pages 9 — 16 for more information regarding the WSL software.
The software performs best using Google Chrome.


https://wsl.shastacollege.edu/Guides/InstructorGuide.pdf
https://www.wsl.shastacollege.edu/
https://www.wsl.shastacollege.edu/
https://www.wsl.shastacollege.edu/
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II. Introduction

Following is the WSL App Instructor Flow Chart (Figure A), which outlines the processes of a WSL Job
from beginning to end from the Instructor perspective. The full reference flow chart is at the end of this
guide. The processes are based on actions taken by different people such as the Student, Supervisor,
and Instructor. Each process has a number, which corresponds to a section in this document that
describes when, how, and by whom the process/task is completed. This document provides general
feature help for the WSL App and explains how to use the WSL App for each process.

1. Instructer
communicates with
Student regarding

10. Instructor
Reviews Student

A 4

Course and WSL App Report
Y v
4. Instructor also .
accesses WSL App, 11. Instructor reviews /

approves Supervisor

re el inkaamd Evaluation of Student

Objectives, approves Job

A 4
7. Instructor visits
Worksite and enters
Worksite Visit info in
Job record

Figure A
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IIlI. Communicate WSL Process and App with Students (Process #1)
The Instructor may wish to conduct an orientation meeting with Students to communicate information
about their course, and about the WSL App and process.

IV. Access WSL System, Review and Approve Student Job (Process #4)

When the Student is finished entering the Job and Objectives info and approves the Job, the Job Status
changes to “Submitted”, and an email is sent to the Instructor to notify them that the Job is ready for
review and approval.

A. Access WSL System and Login
1. Open a web browser and go to the following address: https://wsl.shastacollege.edu. The Login page
will appear (Figure 1).

@ Shasta College Worksite Learning

Select your User Type, enter your Username and Password, and click the [Login] button

User Type: Student ® Instructor Worksite Supervisor

Username:
Password:
Forgot your password?
Login
Figure 1
2. Select your User Type (“Instructor”), enter your username and password (same as your Shasta

College username (not email address) and password), and press the [Enter] key or click the [Login]
button. If you can’t remember your password, click the “Forgot your password?” link.

3. When you first attempt to login, the WSL Program Agreement acceptance window appears. Read

the agreement and click the [Accept Agreement] button (Figure 2). You can view and/or print this
agreement later by selecting the “WSL Program Agreement” menu item from the [Help] menu.
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https://wsl.shastacollege.edu/

Worksite Learning Program

TERMS OF SERVICE AND INDEMNITY
AGREEMENT

For and in consideration of permitting the Shasta Trinity Joint Community College District
Student to enroll in and participate in the District's Worksite Learning Program, all parties
agree to the following:

STUDENT AGREES:

to put in 2ll the hours of work agreed upon as determined by unit amount and by
agreement with the site supervisor.

to consult employer and instructor about any problems, issues or concerns.

to conform to the rules and regulations of the worksite.

to complete required coursework, and furnish all necessary information, reports
and time sheets in a timely manner through the online worksite leaming

Accept Agreement Print Agreement

Figure 2

Review Student Job and Objectives

After you login, the Home screen (Figure 3) will appear, and then you can click the “Jobs” menu item
(or the “Go to Jobs” button) to go to the Jobs list screen (Figure 4). Any new or existing Jobs
associated with you will be displayed automatically for the current Year and Semester. You can also
filter the Jobs list by using the filter fields in the “Filters” section (Figure 4). The Filters section is
hidden by default, but can be toggled by clicking the Filters button.

@ Shasta College Worksite Learning

f Home == Jobs 2 JackRyan~ @ Help -

Worksite Learning System

Worksite Learning (WSL) is an academic program in which students eam college credit for what they learn while working at paid jobs or as volunteers
(even if self-employed). Credits apply to the Associate Degree and can be transferred to 4-year California State Universities as elective credit. There
are other benefits for students, as well. Additional information about the program can be viewed via the Help menu above

Go to Jobs

Figure 3
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@ Shasta College Worksite Learning

& Home 5 jobs 4 Jack Ryan-

Jobs
2 Reset Y Filters

Filters: TGO | XClear
Year: 2019 v Job Status:
Semester: Spring v Student:
Course: Q Worksite: Q
¥

Hide Withdrawn:

Student i~ Worksite - Course / Section - Status ~ Stu Apr ~ Sup Apr ~ Inst Apr ~
Jane Doe Q Zootopia Inc. (Ayn Rand) Q College Algebra (MATH-110), M1234 (3 Pending
units) Q
John Doe Q Acme Company (Jane Public) Q College Composition (ENGL-1A), F1234 Completed
Zootopia Inc. (Ayn Rand) Q (3 units) Q
n Showing 2 of 2 records Records per page:. 20 v
Figure 4

2. Toreview / edit the Job information, click anywhere within the row (e.g. within the sample red
border in Figure 4) of the Job record you wish to review / edit, and the detail Job information will
display directly below the row (Figure 5).

Jane Doe Q Zootopia Inc. (Ayn Rand) Q College Algebra (MATH-110), M1234 (3 Pending

units) Q
m 4= Cancel 2 Send Mail

Job Objectives

Job Status: Pending Mark As v
Year: 2019 Start Date: 1/29/2019

Semester: SPRING End Date: 5/95/2019

Student: Jane Doe Number of Weeks: 17

Job Title: Intern Hours Per Week: 14

Worksite 1: Zootopia Inc. (Ayn Rand) Q Total Hours: 238

Instructor: Jack Ryan Student Approval:

Course: College Algebra (MATH-110) Supervisor Approval:

Section: ) Instructor Approval:

Paid Position:

Worksite Visit Date:

Worksite Visit
Comments:

Figure 5
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3. Inthe Job details display, review the Job information in the Job tab (Figure 5) and the Student
Objectives information in the Objectives tab (Figure 6). Note: Only the Instructor Approval, Worksite
Visit Date, Worksite Visit Comments, and Mark As fields (Job tab) are editable by the Instructor.

Student i~  Worksite ~  Course/ Section ~ Status ~ StuApr ~ SupApr~ InstApr -
Jane Doe Q Zootopia Inc. (Ayn Rand) Q College Algebra (MATH-110), M1234 (3 Pending
units) Q
+ Cancel X Send Mail
Job Objectives

LEARNING OBJECTIVES: It is necessary to identify new leamning objectives each semester/session that the student is enrolled in the Worksite Learning Program.
Objectives must be specific, measurable, and accomplished within the semester/session. Students and site supervisors formulate the objectives. They are reviewed and
approved by the student, site supervisor, and instructor. Evaluation at student's end will include site supervisor's input and will be initiated by the instructor. Discussion will
include progress on the specific objectives and overall job performance.

Worksite v Objective
Zootopia Inc. This is an objective. Saving this objective.
Zootopia Inc. This is an objective.
Zootopia Inc This is an objective.
Zootopia Inc. Test objective
Figure 6

4. Instructors can work with the Student and Worksite Supervisor to develop Objectives. To edit an
Objective, click within the row of the Objective record, and the Objective detail will display directly
below the row (Figure 7).

Worksite - Objective
Acme Company This is an objective.
Objective: This is an objective
A
Figure 7

5. Edit the Objective and click the [Save] button in the toolbar. Repeat steps 4 and 5 for each Objective.

Approve Student Job and Objectives
1. Click the Instructor Approval checkbox in the Job tab (Figure 5), and then click the [Save] button in
the toolbar directly above the Job tab. Note: After the Job is approved by the Student, Supervisor,
and Instructor, the Job Status will change to “In Progress”.

V. Instructor Worksite Visit (Process #7)

Instructor Enters Worksite Visit Information
1. After the Worksite visit, the Instructor accesses the WSL App, and then edits the specific Job record.

2. Enter the date of the visit in the Worksite Visit Date field (Figure 5).
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3. Enter any comments/notes from the visit in the Worksite Visit Comments field (Figure 5). Note: Only
the Instructor can view the Worksite Visit Comments.

VI. Student Report (Process #10)

A. Instructor Reviews Student Report
1. Atthe end of the course, the Instructor accesses the WSL App, and then edits the specific Job
record.

2. Onthe Job details screen, click the Report tab and evaluate the report (Figure 8). If the student
uploaded their report or provided additional documents for their online report, you can access
those documents by clicking the “Report Uploads” (Figure 9).

Job Objectives Timesheets Report Evaluation

At the conclusion of your Worksite Leaming course, you may be required to submit a written assignment that supports what you have leamed in the workplace. Use your
instructor's course syllabus and your timesheet records as a point of reference.

Enter your written assignment in the Report Editor ("word processor") box below and/or upload your report or suppoerting documents in the Report Uploads tab. Note: Be sure
to click the [Save] butten to save your work periodically. Tip: to determine the approximate number of written pages you have entered, you can use the 250 words per page
standard.

* If you are currently seeking Worksite Learning course credit with your present employer, the agreed upon objectives between you and your employer must differ from

current duties and responsibilities.

Report Editor Report Uploads

Test Report 7

This is my report.

Figure 8

Job Objectives Timesheets Report Evaluation

At the conclusion of your Worksite Leaming course, you may be required to submit a written assignment that supports what you have learned in the workplace. Use your
instructer's course syllabus and your timesheet records as a point of reference.*

Enter your written assignment in the Report Editor ("word processor”) box below and/or upload your report or supporting documents in the Report Uploads tab. Note: Be sure
to click the [Save] button to save your work pericdically. Tip: to determine the approximate number of written pages you have entered, you can use the 250 words per page
standard

*If you are currently seeking Worksite Learning course credit with your present employer, the agreed upon objectives between you and your employer must differ from
current duties and responsibilities.

Report Editor Report Uploads
Search By:~ | | Q < Reset
Description Action
Test 2 View
> Showing 1 of 1 records Records per page:| 20 v
Figure 9
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VII.

Supervisor Evaluation of Student (Process #11)

The Worksite Supervisor will complete the student evaluation. After the evaluation is approved by the
Supervisor, the Instructor will be notified by email. After the Instructor has approved the evaluation, the
Job Status will change to “Completed,” and all participants will be notified by email of the completion
status. Also, the Student will be able to view the evaluation (read-only).

A.
1.

Instructor Reviews / Approves Supervisor Evaluation of Student

Access the WSL App and view the specific Job record.

2. On the Job details screen, click the “Evaluation” tab (Figure 10).

5.

Student LI~  Worksite ~  Course/ Section -~ Status - StuApr -~  Sup Apr ~
John Doe Q Acme Company (Jane Public) Q College Composition (ENGL-1A), F1234 In Progress ¢ ¢
(3 units) Q

+ Cancel X Send Mail

Job Objectives Timesheeis Report Evaluation

Supervisor: Click the record below to complete the required student evaluation form

Inst Apr ~

Evaluation Instructions As the employer or supervisor of the above-named student enrolled in a worksite leaming class at Shasta College, please evaluate the student in
the following categories. Your recommendations, comments, and constructive criticism will be part of the student's evaluation in the course. In each of the categories, please
rate the student between one (1) and five (5) where 1 = Unsatisfactory, 2 = Needs Improvement, 3 = Satisfactory. 4 = Above Average, and 5 = Excellent. The grade for this

class will be based upon the following Worksite Learning Skills and Course Objectives.

Worksite

~  Supervisor Approval Instructor Approval

I Acme Company

1/21/2019

Figure 10

Click the row of the specific Worksite’s evaluation of the Student. (Figure 10).

The Evaluation details screen appears (Figure 11) directly below the row. Review the evaluation in
each tab (i.e. “Course Objectives”, “Worksite Learning Skills”, and “Comments / Approval”).

Worksite

Acme Company

Course Objectives Worksite Learning Skills Comments / Approval

Step 3 - Provide Comments & Approval

Comments: Evaluation comments here

Supervisor Approval:

1/21/2019 1:30:24 PM

Instructor Approval:

Created By: john.doe Updated By:
Created Date/Time: 1/20/2019 3:38:01 PM Updated Date/Time:
Figure 11

Supervisor Approval Instructor Approval

¥ 1/21/2019

jpublic

1/21/2019 1:30:24 PM

In the “Comments / Approval” tab, click the Instructor Approval checkbox to approve the evaluation
(Figure 11), then click [Save] button in the toolbar directly above the “Course Objectives” tab.
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VIII. Other Features

A.

Multiple Worksites per Job

Students can add up to three Worksites per Job. This feature was requested for Students who may not
be able to get enough hours at one Worksite in order to fulfill their course requirements. See Student
Guide for details.

B.

Upload / Attach Documents to a Course

Instructors can upload and attach documents (e.g. syllabus or special program documents) to a course,
which are viewable by Students and Supervisors. Follow these steps:

1.

In the Jobs list screen, click the “magnifying glass” icon at the end of the Course title in the “Course /
Section” column (Figure 12).

Student I~  Worksite ~  Course / Section -
John Doe Q Acme Company (Jane Public) Q College Camposition (ENGL-1A), F1234
(3 unitg
Figure 12

When the Course details window appears, click the “Course Docs” tab (Figure 13), and the Course
Docs list will display. To view the Course Doc details, click the row of the document. The Course Doc
details also contains a link to download the document. To just view the document in the browser,
click the “View” link in the “Action” column of the row.

Course Detalil
X Cancel
Course Course Docs
Search By:~ | | Q + New 2 Reset
Instructor - Description Action
Jack Ryan Sample Doc Wiew
n Showing 1 of 1 records Records per page:
20 v
Figure 13

To upload a new Course Doc, click the [New] button (Figure 13) in the toolbar, and a blank Course
Doc screen will display for entry (Figure 14).
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C.

Course Course Docs

M save < Cancel

Instructor: Instructor 4
Description:
Action:

Figure 14

Enter the document description (e.g. Syllabus).
Click the [Browse] button next to the “File” field to select the document that you want to upload.

After you have the document selected and its file name is displayed in the “File” field, click the
[Save] button in the toolbar directly above the Instructor field.

View Contact Info for Student and Worksite Supervisor

Instructors can view contact information for a Student or Supervisor by clicking the “magnifying glass”
icon next to the student’s or supervisor’s name.

1.

Student Contact Info (Figure 15):

Student I3~ ;
Student Profile
John Dol Q
X cancel
Student 1234567 Phone 530-555-1213
1D: Nbr:
First John Email john.doe@gmail.com
Name: Address:
Middle R Username: john.doe
Name:
Updated 12/28/2018 3:18:53 PM
Last Doe Date/Time:
Name:

Figure 15
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2. Worksite Supervisor Contact Info (Figure 16):

Worksite - H H 1
Worksite Supervisor Profile

Acme Company (Jane PublicE

® Cancel
Worksite Acme Company Phone: 5305551214
Name:
Email: jpublic@acme.com
Street 12345 Main St.
Address:
City, Redding. CA 96001
State, Zip:
Supervisor Jane Public
Name:
Figure 16
D. Send Email to Worksite Supervisors and/or Students

You can send an email directly to one or more of the Worksite Supervisors and/or Students from within
the WSL App. Note: the email is sent from your email address, and a copy of the message is also sent to
your email address. There are two methods to send email: 1) send to the Student and Worksite(s) within
a single Job record, or 2) send to multiple Students and Worksite(s) of multiple Jobs.

Send Mail to Supervisor(s) and/or Student within a Job
1. While in aJob details screen, click the [Send Mail] button (Figure 17) in the toolbar.

+ Cancel X Send Mail

Job Objectives

Job Status: Pending
Year: 2019
Figure 17

2. When the Email Form appears, click the checkboxes next to the desired recipients, enter the Subject
and Message, and then click the [Send] button (Figure 18).
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Email Form
send To: Jane Doe [ Ayn Rand (Zootopia Inc.) L Mas
Caffeine (Theory Coffee)
Subject: | |
Message:
4
Send Cancel
Figure 18

Send Mail to Multiple Students and Worksite(s) of Multiple Jobs

1. While in the Job list screen, click the checkbox next to one or more Jobs that are related to the
Supervisors and/or Students that you want to email, then click the [Send Multi-Mail] button (Figure
19) in the Jobs toolbar.

Jobs

2 Reset Y Filters = Send Multi-Mail

[ student i~  Worksite v

Jane Doe Q Zootopia Inc. (Ayn Rand) Q
. Theory Coffee (Mas Caffei

John Doe cme Company (Jane Public)
. Zoolopia Inc. (Ayn Rand) Q

Figure 19

2. When the Multi-Mail Form appears, click the “Students” and/or “Worksite Supervisors” checkboxes,
enter the Subject and Message, and then click the [Send] button (Figure 20).

Multi-Mail Form

Send To: Students L Worksite Supervisors
Subject:

Message:

Send Cancel

Figure 20
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E. Mark Job as “Unfinished” - Manual Completed Override
Sometimes, there are special cases where a Job doesn’t go as planned.

Scenario 1: A Student does not complete the Job or course requirements, but also does not drop the
class, the Instructor may mark the Job with the “Unfinished” status.

1. Access the WSL App and view the specific Job record.

2. Inthe Jobs detail screen, select the “Unfinished” option from the “Mark As” drop-down-list field
(Figure 21).

m + Cancel = Send Mail

Job Objectives

Job Status: Pending Mark As Unfinished v

Year: 2019 Start Date: 1/29/2019

Figure 21
3. Click the [Save] button in the Jobs toolbar, and the Job Status will change to “Unfinished”.

Scenario 2: If the Instructor allows the Student to finish the Course later due to some extenuating
circumstances.

Scenario 3: If the Student does complete the Course requirements, but one of their Worksite
Supervisors cannot login to the system to perform the final Evaluation and approval (e.g. Supervisor left
the company).

In scenarios 2 and 3, the Instructor can contact the WSL System Administrator through the “Technical
Support” option under the Help menu, and request that the Job record be marked as “Manual
Completed Override,” which will change the Job Status to “Completed”.

IX. User Profile

Your User Profile displays your contact information that Students and Worksite Supervisors may see
(read-only). It also allows you to edit your phone number and email address.

1. Select the User Profile menu item from the User menu (i.e. your name is the menu title) next to the
Help menu.

2. If necessary, edit your phone number and email address and click the [Save] button in the toolbar
(Figure 22).
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Instructor Profile

First Instructor Username: instructor4
Name:

Updated 1/1/2019 12:00:00 AM

Last 4 Date/Time:
Name:

Phone 555-555-5558
Nbr:

Email instructord@shastacolle
Address:

Figure 22

X.  Technical Support

For technical support, please submit requests by selecting the Technical Support option under the Help
menu.

1. Enter the fields in the form and click the [Submit] button in the toolbar (Figure 23).

WSL Technical Support Request
® Cancel
Name: Jack Ryan
Subject:
Reguest:
P2
Email: jryan@shastacollege.edu
Phone: 530-555-1217
Figure 23
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XI.

WSL Application Process Flow Chart - Page 1

Worksite Learning Program

Application

Process Flow Chart

Action By:

Instructor ‘

WSL App

Load initial Students
and Sections into WSL

database for semester

4. Instructor also
accesses WSL App,
reviews Job info and
Objectives, approves Job

1. Instructor
communicates with
Student regarding
Course and WSL App

If new Worksite
Supervisor, then
User info emailed to
them

After approval by
Student, Job Status
changes from

Pending to
Submitted

Job Status
Submitted
notification emailed
to Instructor and
Supervisor

After Worksite
Supervisor and
Instructor approvals,
Job Status changes
to In Progress

Job Status In Progress (all
approved) notification
emailed to Student,
Supervisor, and
Instructor
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XII.

WSL Application Process Flow Chart - Page 2

o

gl

Action By:

Instructor

WSL App

7. Instructor visits
Worksite and enters
Worksite Visit info in

Job record

After Supervisor
evaluation approval,
tion emailed

to Instructor

10. Instructor
Reviews Student
Report

A 4

11. Instructor reviews /

approves Supervisor
Evaluation of Student

After Instructor
evaluation approval,
Job Status ch

Completed

Job Status Completed
notification emailed to
all Job related Users
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